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Welcome 

Introduction 

Welcome to the Sysgem Access Gateway – an easy-to-use remote access 

solution which leaves you in control of your data. 

This User’s Guide describes the features of the Access Gateway client – the part 

of the Access Gateway software that allows you to view and control the screen 

of a remote computer running the Access Gateway Remote Connector.  Other 

parts of the Access Gateway documentation cover the features of the Access 

Gateway itself and the Access Gateway Remote Connector software.  For more 

details, please see the About This Manual section. 

About This Manual 

This is the fourth of four volumes of documentation provided with the Access 

Gateway; the complete documentation set consists of: 

 Volume 1: Getting Started 

 Volume 2: Configuration and Administration Guide 

 Volume 3: Remote Connector User’s Guide 

 Volume 4: Access Gateway Client User’s Guide 

The other three volumes should be available from the same location as this one 

or from your distributor or the Sysgem website. 

 When additional information is available on a particular topic, a note like 

this one will let you know in which volume it can be found. 

This User’s Guide covers the features and options available to users of the 

Access Gateway client, which is used to connect to Access Gateway sessions 

created by users of the Access Gateway Remote Connector and is included as an 

integral part of any SysMan product. 

The guide is broken into sections, initially covering the basic functionality of 

connecting to a session through the SysMan user interface before going on to 

look at the Access Gateway-specific features of the SysMan Remote Control 

client software. 

 As you work through the guide, you’ll find occasional side comments (like 

this one) that include useful hints that aren’t part of the main workflow.  

Alternatively they might indicate that certain features are advanced 

features that will be covered elsewhere. 
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Some terms used in this guide may be introduced in italics; we hope their 

meaning will be explained by the surrounding text, but they are also described in 

the Glossary section at the back of the guide. 

Throughout this guide, screenshots and example configurations are shown to 

help illustrate the principles being discussed.  Whilst representative, there might 

be slight variations between the example shown in the guide and what you see 

on your screen; in some cases this may be due to differences between Windows 

environments, but in others it could be because of minor changes to the Access 

Gateway software.  Sysgem makes every effort to ensure that such changes do 

not impact upon the functionality being described, but if you encounter difficulty 

please contact us at support@sysgem.eu for assistance. 

mailto:support@sysgem.eu
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About the Access Gateway 
Client Software 

What Does the Access Gateway Client Do? 
The Access Gateway client allows you to quickly and easily connect to a remote 

control session that has been established by a user running the Access Gateway 

Remote Connector.  Once connected, you can view or control the remote user’s 

screen, even across network boundaries. 

What Do I Need to Get Started? 
To get started with the Access Gateway client, you simply need a suitable 

SysMan installation (as described in the Installation and Configuration section) 

along with the details required to register with your Access Gateway.  These 

consist of the Gateway’s address (either an internet address such as 

gateway.sysgem.com, or an IP address such as 10.0.1.2), and possibly an 

account name and corresponding password.  These details should be provided to 

you by the administrator of your Access Gateway. 

What Types of Sessions Can I Connect To? 

Using the Access Gateway client, you can connect to any Access Gateway 

session created by a user (whether inside or outside your local network) running 

the Access Gateway Remote Connector – subject to any access permissions 

configured by your Access Gateway administrator. 

These sessions include temporary (non-persistent) sessions that are available 

only until the remote user closes the Remote Connector, and persistent sessions 

that are configured to be available whenever the remote computer is running. 

 Please see the Remote Connector’s User Guide for more details on the 

different types of sessions available through the Access Gateway. 

If there are particular persistent sessions that you use frequently – for instance, 

your workstation in another office, or a server you are responsible for – you can 

store these sessions as session shortcuts for quick access in the future. 

In addition, as the Access Gateway client software is included as part of the 

SysMan Remote Control client, you can also use it to connect to any SysMan 

Remote Control servers running on your network. 
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Notes: 
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Installation and Configuration 

The Access Gateway Client and SysMan 

The Access Gateway client software is included as part of the SysMan Remote 

Control client, which is installed along with any SysMan product.  If you have 

an existing SysMan installation you do not need to install a new one just for the 

Access Gateway; the Access Gateway client features are included in every 

edition of SysMan: 

• SysMan Utilities Standard Edition 

• SysMan Utilities Professional Edition 

• SysMan Utilities Free Edition 

• SysMan Remote Control 

Including the Access Gateway client in the existing SysMan Remote Control 

client allows it to take advantage of the familiar SysMan Explorer interface for 

connecting to and managing Access Gateway servers and sessions. 

Installation and Prerequisites 

As described above, the Access Gateway client is available in every SysMan 

installation kit; in addition, the main Access Gateway installation kit includes an 

option to install the Access Gateway client along with the other Access Gateway 

components.  When this option is chosen, the latest SysMan Remote Control kit 

is automatically downloaded and installed as long as there is no existing SysMan 

installation on the target computer. 

 If you are installing the Access Gateway client on a computer without also 

installing the Access Gateway server, you may wish to install using a 

standalone SysMan kit instead. 

If you already have a member of the SysMan family of products installed on the 

computer where you wish to install the Access Gateway client, you may simply 

need to make sure it is up-to-date to receive the Access Gateway support; please 

see the Updating an Existing SysMan Installation section later in this chapter for 

details. 

The SysMan products have no software prerequisites – their installation kits 

contain everything required to get started – but if you use the full Access 

Gateway kit, it will check for the .NET Framework (required by other Access 

Gateway components) and install it if missing.  Since SysMan and the Access 

Gateway client themselves do not use the .NET Framework, this overhead may 

be undesirable.  If this is a concern, Sysgem recommends using a standalone 

SysMan installation kit instead. 
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 If you only have the main Access Gateway kit, you can obtain the 

standalone SysMan installation kits from your distributor or from Sysgem. 

SysMan Editions 

The SysMan family of products includes several editions with different 

capabilities, to allow you flexibility in choosing a product that best suits your 

needs. 

All SysMan editions are capable of connecting to an Access Gateway as a client 

(and also managing the Access Gateway itself); however, the editions differ in 

what other functionality is available. 

SysMan Utilities Professional Edition stands apart from the other editions by 

providing a multi-user system, with centralized control and auditing of users’ 

privileges and actions on managed systems.  When using the Professional 

edition, you can restrict the Access Gateway client and management features 

available to individual users as appropriate – for instance, one group of SysMan 

users might be able to modify Access Gateway account details and settings, 

while another group might only be able to connect to Access Gateway sessions 

as a client. 

 More information on configuring users and access restrictions is available 

in the documentation supplied with SysMan Professional Edition. 

SysMan Utilities Standard Edition includes all the management tools available in 

the Professional Edition (both for the Access Gateway and for general Windows 

system management), but without the centralized user management and auditing.  

Similarly, the Free Edition includes the same suite of tools but with restrictions 

on how many Windows computers can be managed at any one time. 

Finally, the SysMan Remote Control product includes only the remote control 

and Access Gateway client and management functionality; other Windows 

management tools are not included.  In order to concentrate on the Access 

Gateway-specific functionality of the SysMan family, it is this edition that we 

use for the examples in the Access Gateway documentation. 

 Your Access Gateway license includes one SysMan Remote Control 

license for every licensed Access Gateway channel; this allows you to 

have as many users of SysMan Remote Control as you can have 

concurrent Gateway sessions.  If you have more users, you may need 

additional SysMan licenses. 
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Installing a New SysMan Installation 

Installation of SysMan is straightforward; the installation routine will ask you to 

agree to the SysMan license agreement, and then to provide your name and 

company details.  Once these steps are complete, just continue through the 

wizard until SysMan has been installed. 

 

Once the installation has completed, you will be asked if you wish to start 

SysMan right away.  Tick the box and click Finish to launch the SysMan 

environment; alternatively, you can leave it without a tick and launch SysMan at 

a later time using the relevant icon on your Windows desktop or Start Menu: 
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When SysMan starts, it will display the SysMan Explorer and Getting Starting 

windows as shown below: 

 

You are now ready to continue with registering the Access Gateway with the 

new client installation, as described in the Configuration section. 

Updating an Existing SysMan Installation 

The Remote Control client support for the Access Gateway was first introduced 

in SysMan version 3.0.0, along with the Access Gateway management tools.  If 

you have an existing SysMan installation that predates this version, you will 

need to ensure it is up-to-date before you will be able to connect to your new 

Access Gateway installation. 

To check the version of SysMan you are currently running, start SysMan as 

usual (and log in, in the case of SysMan Professional), and then select SysMan 

About from the Bookmarks pane: 
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This will display the SysMan About window, containing details about your 

currently-installed SysMan version: 

 

If the module version shown is before 3.0.0, you will need to update to the latest 

version.  The update kit can be obtained either by selecting the option to 

download it from the SysMan About window, or from your distributor; once you 

have obtained it, it can simply be installed over the top of your existing 

installation following the usual installation procedure for your SysMan edition. 

 If you are using SysMan Utilities Professional Edition, you may only need 

to update the central Authorization Server – however, you should also 

check the user Tokens you have configured within SysMan to ensure that 

you have been granted access to the new Access Gateway features.  An 

upgrade installation of the Professional Edition does not change your 

existing Tokens, to ensure your permission settings remain intact. 

 More information about updating SysMan can be found in the 

documentation supplied with SysMan. 

Configuration 

When you start SysMan (having logged in, if using SysMan Professional), the 

SysMan Explorer window will open automatically; included in the tree view on 

the left of the window will be a branch for Access Gateways: 
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This branch will include an entry for each Access Gateway you have registered 

with your SysMan installation, and all Access Gateway client actions (as well as 

management of the Access Gateway itself) take place using these registrations. 

 If you are using SysMan Utilities Professional Edition, each SysMan user 

has their own independent, personal set of Access Gateway registrations. 

To connect through a new Access Gateway (or to manage it), you will need to 

register it with SysMan so that it appears in this branch of the SysMan Explorer 

tree.  The next section explains how the registration process works. 

 If you have installed SysMan on the same computer as your Access 

Gateway server, a suitable registration should be created automatically. 

Access Gateway Registrations 

Each Access Gateway registration collects together the information needed to 

connect to the Gateway with the Access Gateway client – the name or address of 

the computer on which the Access Gateway server is running, and an optional 

account name and corresponding password – as well as the details used to 

connect to it via WMI for management purposes. 

 If you only need to use a Gateway as a client, or you only want to manage 

a Gateway without connecting through it, you can tell SysMan this so that 

it does not request the additional details or show you irrelevant options. 

To create a new Access Gateway registration, simply select the Access Gateways 

folder in the SysMan Explorer tree view and then double-click the Register New 

Gateway option on the right-hand side: 
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The Register Access Gateway wizard will appear with some introductory text: 

 

Click Next to continue; you will be prompted to provide the connection details 

for your Access Gateway, as used for Access Gateway client connections. 

 Your Access Gateway administrator should have provided you with an 

Access Gateway address, along with any account name or password you 

may require; alternatively, you may have been given an Access Gateway 

Registration file containing the relevant details. 

You have two options here – either to register with your Access Gateway by 

specifying details manually, or (if you have one) to use an Access Gateway 

Registration file to provide all the details automatically. 

Providing Details Manually 

To register with the Access Gateway by specifying details manually, first ensure 

the ‘Access Gateway address’ option is selected and then type the address of 

your Access Gateway server in the Address field: 
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Click Next, and the wizard will check that it can connect to the specified address. 

If the connection is successful, the wizard will prompt you to confirm the 

account credentials you wish you use: 

 

 If an error message appears, make sure you typed the address of the 

Gateway correctly and try again; if the test connection still fails, consult 

your Access Gateway administrator and ensure your network and firewall 

configuration allows you to access the Access Gateway server at the 

address you specified. 

Click Next to continue; the wizard will verify that the provided credentials are 

correct, and then display the Management page.  On this page you can specify 

the name or address required to connect to the computer where the Access 

Gateway is installed for management purposes, if this differs from the details 

used for viewer connections. 

 

 If you do not need to manage the Access Gateway, you can tick the Skip 

This Step checkbox.  However, this also disables the Current Sessions list; 

please see the Management Tools section below for more information. 
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After you click Next on this page, the wizard will check if additional Windows 

credentials are needed to access the selected computer; you may be prompted for 

these if necessary. 

Once you have provided all the required details, the Save Access Gateway 

Registration page appears: 

 

You can either accept the default registration name or specify a different one, if 

desired.  Click Apply to save the registration under the specified name; the 

SysMan Explorer window will refresh and your new registration will appear 

under the Access Gateways branch of the tree: 

 

Using a Access Gateway Registration File 

An Access Gateway Registration file allows you to quickly and easily create a 

registration for a new Access Gateway without needing to provide and verify the 

connection details individually. 

 Note that a registration created from an Access Gateway Registration file 

is not enabled for management by default; this means the Current Sessions 

list is not available.  Please see the Management Tools section below for 

more information. 
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To register with the Access Gateway using a registration file, first select the 

‘Access Gateway Registration file’ option; this will enable the File field: 

 

Click on the arrow to the right-hand side of the field to display a standard Open 

File dialog box; navigate to and select your Access Gateway Registration file, 

which will usually have the .agr extension.  Once selected, the full path will 

appear in the File field of the registration wizard: 
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Click Next to continue; the wizard will use the details in the file to connect to the 

Access Gateway server and verify the provided information before displaying 

the Save Access Gateway Registration page: 

 

You can either accept the default registration name or specify a different one, if 

desired.  Click Apply to save the registration under the specified name; the 

SysMan Explorer window will refresh and your new registration will appear 

under the Access Gateways branch of the tree: 

 

Management Tools 

In addition to the Access Gateway client software, SysMan includes the Access 

Gateway Management Tools.  These tools use Windows Management 

Instrumentation (WMI) to connect to and configure Access Gateway servers; 

since WMI is a powerful tool for administration of remote computers, it is 

usually only available within a private network and often only to suitably-

privileged users. 

If you do not have WMI access to the computer where the Access Gateway is 

running, or if you do not wish to manage the Access Gateway, you can choose to 

disable the Management Tools from within the Register New Access Gateway 

wizard.  However, in this case you should be aware that some of the 

functionality described in this guide will not be available – most notably, the 

Session List described in the Connecting to Sessions section requires WMI 

access to work.  Without WMI access configured, you will only be able to 

connect to sessions for which you have been provided an access code. 

You can also choose whether or not the Management Tools are available, and 

provide any required connection details, using the Registration Details tool for 

each Access Gateway registration. 

 Please see the Windows Management Instrumentation (WMI) section of 

the Configuration and Administration Guide for more details.  
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Notes: 
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Connecting to Sessions 

Introduction 

There are three ways to connect to a remote user’s Access Gateway session; 

which one you use might depend on various factors such as what information 

you have, the details of your SysMan configuration or permissions, and the 

environment in which your Access Gateway system has been deployed. 

The three methods are: 

 Connecting using an access code provided by the remote user 

 Connecting by choosing a session from the Session List 

 Connecting to a session you have stored as a shortcut for frequent access 

If you are not able to use the Access Gateway Management Tools, as previously 

described in the Click Next to continue; the wizard will use the details in the file 

to connect to the Access Gateway server and verify the provided information 

before displaying the Save Access Gateway Registration page: 

 

You can either accept the default registration name or specify a different one, if 

desired.  Click Apply to save the registration under the specified name; the 

SysMan Explorer window will refresh and your new registration will appear 

under the Access Gateways branch of the tree: 
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Management Tools section, then you will not be able to view the Session List 

and so you will need to either obtain an access code from the remote user or use 

a persistent session that has previously been saved in your Session Shortcuts list. 

In the following sections, we will explore these three approaches and the 

situations in which you might use each one. 

Connecting Using an Access Code 

If you know the access code for the session you want to connect to, you can use 

it to connect directly to the session. 

To do this, select the correct Access Gateway registration in the SysMan 

Explorer tree; the right-hand side of the Explorer window will change to show 

the various available options: 
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Double-click on the Connect with Code option; the Connect via Access Gateway 

Code window will appear: 

 

Type the access code in the relevant field, and then click Apply: 

 

 Don’t worry about the Options fields at the bottom of the window for the 

moment.  We will return to them in later sections of this guide. 



 

20    Connecting to Sessions Sysgem Access Gateway Client User's Guide 

The SysMan Remote Control window will open and automatically establish a 

connection to the Access Gateway session.  When this completes, a prompt will 

appear to allow you to authenticate with the SysMan Remote Control Engine: 

 

Enter a valid Windows username and password with Administrator access to the 

remote computer; alternatively, if a session password has been configured for the 

SysMan Remote Control Engine, you can instead change the Type: field to 

‘SysMan Remote Control (with session password)’ and enter that password. 

 You are also provided with the option to save the details you have entered 

as connection preferences either for this particular remote computer or as 

defaults for all future Access Gateway connections; these will be securely 

stored as part of your SysMan configuration, allowing you to avoid 

retyping your details at this credentials prompt for future sessions. 

Finally, click OK to confirm your credentials and establish the connection.  The 

SysMan Remote Control window will display the remote computer’s desktop: 

 

 If you instead receive an ‘authentication rejected’ error message, click OK 

to dismiss it; the credentials prompt will re-appear and you can verify that 

you entered the correct details before trying again.  However, you may 

need to obtain a new access code first; some access codes are only valid 

for a single connection attempt. 
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 More details on using the SysMan Remote Control client are available in 

the Using the SysMan Remote Control Client section. 

Connecting via the Session List 
If you do not know the access code for the session you wish to connect to, you 

can instead view a list of active sessions and connect to one from there. 

Please note that this requires you to have the permissions and network access 

required to manage the Access Gateway; please see the Click Next to continue; 

the wizard will use the details in the file to connect to the Access Gateway server 

and verify the provided information before displaying the Save Access Gateway 

Registration page: 

 

You can either accept the default registration name or specify a different one, if 

desired.  Click Apply to save the registration under the specified name; the 

SysMan Explorer window will refresh and your new registration will appear 

under the Access Gateways branch of the tree: 

 

 Management Tools section for more details on these requirements. 

To view the list of active sessions, select the relevant Access Gateway from the 

list of registrations in the SysMan Explorer window, then double-click on the 

Current Sessions tool in the right-hand side of the window: 
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 The Current Sessions will not appear if you have configured the Access 

Gateway registration without support for the management tools. 

The Access Gateway Current Sessions window will appear on the right-hand 

side of the workspace, and after a moment will display a list of currently-active 

sessions: 

 

 As shown above, some sessions listed in the Current Sessions window may 

appear highlighted in orange.  These sessions are non-persistent sessions to 

which no viewers are currently connected; they are highlighted for easy 

identification, for instance in a situation where remote users are seeking 

assistance from helpdesk staff. 
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Find the session you would like to connect to in the list, and double click on it.  

The Connect to Session form will appear, showing basic information about the 

selected session: 

 

 If you have multiple Access Gateway registrations that refer to the same 

Access Gateway server but using different account names, you may need 

to select the correct registration in the Access Gateway field in the 

Connection section of the window. 

When you are happy that the session described in the window is the one you 

wish to connect to, click Apply to continue with the connection. 

 Don’t worry about the Options fields at the bottom of the window for the 

moment.  We will return to them in later sections of this guide. 

The SysMan Remote Control window will open and automatically establish a 

connection to the Access Gateway session.  When this completes, a prompt will 

appear to allow you to authenticate with the SysMan Remote Control Engine: 

 

Enter a valid Windows username and password with Administrator access to the 

remote computer; alternatively, if a session password has been configured for the 

SysMan Remote Control Engine, you can instead change the Type: field to 

‘SysMan Remote Control (with session password)’ and enter that password. 
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 You are also provided with the option to save the details you have entered 

as connection preferences either for this particular remote computer or as 

defaults for all future Access Gateway connections; these will be securely 

stored as part of your SysMan configuration, allowing you to avoid 

retyping your details at this credentials prompt for future sessions. 

Finally, click OK to confirm your credentials and establish the connection.  The 

SysMan Remote Control window will display the remote computer’s desktop: 

 

 If you instead receive an ‘authentication rejected’ error message, click OK 

to dismiss it; the credentials prompt will re-appear and you can verify that 

you entered the correct details before trying again.  However, you may 

need to obtain a new access code first; some access codes are only valid 

for a single connection attempt. 

 More details on using the SysMan Remote Control client are available in 

the Using the SysMan Remote Control Client section. 

Connecting to Frequently-Used Persistent Sessions 
If there are certain persistent sessions that you use frequently – for instance, your 

workstation in another office or a server that you are responsible for – then you 

can save them in the Sessions Shortcuts list for the relevant Access Gateway. 

 You can only save persistent sessions, since they have an access code that 

remains consistent over time; a non-persistent session’s access code is only 

valid for the duration of that session. 

Saving a Persistent Session 

To save a persistent session, you first need to connect to it using either its access 

code or by selecting it from the session list (as described in the previous two 

sections).  However, before clicking Apply in either the Connect via Access 

Gateway Code or Connect to Session dialog boxes, take a look at the Options 

section at the bottom of the form. 
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In this section you should find two options; a checkbox to create a shortcut for 

the session, and a text field that allows you – after ticking the checkbox – to 

specify a descriptive name for the shortcut: 

 

After ticking the option to create a shortcut, providing a name, and successfully 

connecting to the session, the Access Gateway client will save it in the Session 

Shortcuts list under the appropriate Access Gateway registration. 

 You can also create a session shortcut by right-clicking a persistent session 

in the Access Gateway Current Sessions window and selecting Create 

Session Shortcut; as with the Connect to Session dialog box, you will be 

given the opportunity to ensure the correct Access Gateway registration is 

selected and provide a name for the shortcut. 
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Connecting to a Saved Persistent Session 

To reconnect to a persistent session that you have previously saved, as described 

above, select the relevant Access Gateway registration in the SysMan Explorer.  

Your list of saved sessions will appear on the right-hand side of the window, in 

the Session Shortcuts section: 

 

Double-clicking a session from the list will immediately start a connection; if the 

session is currently unavailable (for instance, the remote computer is turned off) 

you will receive an error from the SysMan Remote Control client. 

Session Shortcut Maintenance 

Over time, sessions that you have saved to the Session Shortcuts list may 

become irrelevant and you may want to remove them.  Alternatively, you may 

wish to change the display names you have configured for them. 

To make changes to your saved session shortcuts, double-click the Maintenance 

option at the bottom of the relevant Session Shortcut list.  This will open the 

Access Gateway Session Shortcuts window, which will show each of the 

sessions in the selected Session Shortcut list: 
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Double-clicking an entry in the list will allow you to change the display name 

and access code associated with a particular shortcut; in addition, you can right-

click an entry and connect to it or delete it.  Opting to delete one or more 

shortcuts will produce a confirmation window: 

 

Make sure that the correct shortcuts are listed in the confirmation window and 

click Apply to remove them from your Session Shortcuts list. 
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Notes: 
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Using the SysMan 
Remote Control Client 

Introduction 
As we have already seen in the Connecting to Sessions section, once you have 

selected an Access Gateway session the SysMan Remote Control window 

appears to make the final connection. 

Since Access Gateway sessions are powered by the SysMan Remote Control 

Engine, the same client application is used to connect to them as is used to 

connect to SysMan Remote Control servers directly.  Access Gateway sessions 

support all of the same remote control features that are available when 

connecting directly to a SysMan Remote Control server; however, some of the 

configuration and maintenance options available in the client application do not 

apply to Access Gateway sessions. 

In this section, we will look at the common features that are available for both 

types of connection, as well as some additional features that are specific to 

Access Gateway sessions. 

 More information about the SysMan Remote Control-specific features of 

the client, for instance remote installations of the RC server, can be found 

in the SysMan Remote Control User Guide. 

Access Gateway Specific Features of the 
Remote Control Client 

The main changes in behavior when connecting to an Access Gateway session 

happen during the initial connection. 

Most significantly, when the Connect To dialog box appears to prompt you for 

authentication details, the Server field is grayed out and cannot be altered – this 

is because the session you have selected already identifies the computer to be 

controlled. 

 The ‘save these credentials for future use’ options in the Connect To 

dialog behave slightly differently for Access Gateway connections; please 

see the Remote Control Authentication section for details. 

By default, the Remote Control Client selects Low Bandwidth Mode for all 

Access Gateway connections.  This allows for improved performance when 

using the Access Gateway across the Internet, but since the visual quality is 
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reduced in this mode the client will display an explanatory message for the first 

few Access Gateway connections: 

 

 This default behavior can be changed, if desired, using the Connection tab 

of the Preferences dialog box available from the SysMan Remote Control 

client’s File menu. 

When you have connected to an Access Gateway session, the SysMan Remote 

Control client displays a small indicator at the right-hand side of the status bar.  

Clicking on this indicator will display a notification popup reminding you of the 

session details: 

 

Remote Control Authentication 

Authentication to Access Gateway sessions can be performed using either a 

Windows username and password or a session password.  Which of these 

options is available, and which Windows users are granted view-only and 

remote-control permissions, depends on the configuration of the SysMan 

Remote Control Engine on the remote machine. 

Authentication using Windows Credentials 

To authenticate using a Windows username and password, ensure that the Type 

field in the Connect To dialog box is set to ‘SysMan Remote Control (with 

Windows username and password)’, then provide suitable details in the 

Username and Password fields. 

 By default, users in the Administrators group on the remote machine are 

granted full remote-control privileges; other users have no access. 
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Authentication using a Session Password 

To authenticate using a session password, ensure that the Type field in the 

Connect To dialog box is set to ‘SysMan Remote Control (with session 

password)’ and then provide the password in the Password field. 

 The default setting for the connection type is to use Windows credentials; 

however, this can be changed (if required) using the Connection tab of the 

Preferences dialog box available from the SysMan Remote Control client’s 

File menu. 

Saving Credentials for Future Use 

When connecting to Access Gateway sessions, the two options to save the 

connection settings for future use with the same server or as default settings for 

all servers behave slightly differently than they do when making direct 

connections to SysMan Remote Control servers. 

Because some types of Access Gateway session only allow one client connection 

before the access code becomes invalid, the Remote Control client does not 

immediately attempt a connection using any saved credentials it finds (either for 

the particular computer running the session or as default credentials).  Instead, it 

displays the Connect To dialog box as usual, with the saved credentials already 

filled in; if you want to continue connecting with these credentials, simply click 

OK.  However, if the credentials need to be changed, you have the opportunity to 

do so before continuing. 

Display Settings 

When connected to a session, the options on the View menu can be used to 

control how the remote image is displayed to you: 

 Monitors: this submenu allows you to select whether the entire remote 

desktop should be displayed in your window, or (if the remote computer has 

multiple monitors attached) to select an individual monitor to view. 

 Full Screen: when selected, fills the entire screen with the SysMan Remote 

Control display area, leaving just the menu bar visible along the top edge of 

the screen.  You can return to a normal window by deselecting the option. 

 Shrink To Fit Window: when selected, ensures the entire remote display is 

visible in your SysMan Remote Control window. 

 Resize Window To Fit: reshapes the SysMan Remote Control window so 

that it accommodates as much of the remote display as possible. 

 View Only: prevents your mouse and keyboard from controlling the remote 

session, for instance to avoid inadvertent interference with the remote user. 

 Lock Remote Keyboard and Mouse: temporarily disables the remote 

user’s keyboard and mouse, for instance to avoid inadvertent interference 

with your actions on the remote machine. 

 Low Bandwidth Mode: when enabled, reduces the visual quality of the 

display in order to improve performance across slow network connections. 

 Local Cursor: this submenu allows you to select how the location of your 

own mouse cursor should be shown in the window, if at all.  Showing your 

local mouse cursor gives you smoother feedback regarding where you are 

currently ‘pointing’ on the remote machine. 

o Remote Only / Default: if the remote cursor is enabled (see 

below), this hides your local cursor leaving only the remote cursor 
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– if the remote cursor is not enabled, then your normal local cursor 

will be shown. 

o Show as Dot: highlights the position of your own mouse cursor 

with a small dot. 

o Show as Crosshair: highlights the position of your own mouse 

cursor with a small crosshair. 

 Remote Cursor: controls whether the mouse cursor position on the remote 

machine is shown in your window or not.  The remote cursor can provide 

additional feedback, for instance when performing dragging or sizing 

operations, but can also emphasize the slight delay between your actions and 

the response from the remote machine. 

Some of these options are also made available as buttons in the toolbar at the top 

of the window: 

Resize Window to Fit

Shrink to Fit Window

Lock Remote Keyboard and Mouse

 

Controlling the Keyboard and Mouse 

In addition to the View Only and Lock Remote Keyboard and Mouse settings 

found on the View menu, the Send menu allows you to send a variety of key 

combinations that have special meanings to Windows.  These include task 

switching keys (Ctrl-Esc, Alt-Tab, Alt-Esc) as well as system keys such as Ctrl-

Alt-Delete and Ctrl-Shift-Esc. 

Additionally, some of these options are available as buttons in the toolbar: 

Ctrl-Esc

Ctrl-Alt-Delete

Ctrl-Shift-Esc
 

Chat and File Transfer 

During an Access Gateway session, you can communicate with the remote user 

directly by selecting the Chat with Remote option from the Tools menu. 
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A chat window will appear both on your computer and the remote user’s screen, 

which allows you to (for example) ask for additional details about a problem you 

are trying to help the user with: 

 

In addition, you can copy files to and from the remote machine using the 

Transfer Files option on the Tools menu.  This will open a window showing the 

available drives and directories on both your machine and the remote machine, 

allowing files to be copied back and forth as required. 

 

These two options are also available as buttons in the toolbar: 

File Transfer

Chat with Remote
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Disconnecting from a Session 

To disconnect from an Access Gateway session, you can either: 

 Close the SysMan Remote Control client window 

 Select the Disconnect option from the File menu 

 Click the Disconnect button in the toolbar (below) 

Disconnect
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Glossary of Terms 

A 

access code 

A short code used to identify and connect to an Access Gateway session. 

Access Gateway account 

A name and password used to connect to an Access Gateway server. 

Access Gateway client 

The software used to connect to an Access Gateway session and view or 

control the remote user’s screen.  Included with and installed as an integral 

part of all SysMan products. 

Access Gateway Management Tools 

The software used to configure and manage an Access Gateway server.  

Included with and installed as an integral part of all SysMan products. 

Access Gateway registration 

The configuration information required to connect to a given Access 

Gateway, given a friendly name for reference and stored within the Remote 

Connector, Access Gateway client and Management Tools. 

Access Gateway Registration file 

A file containing all the details required to connect a Remote Connector or 

Access Gateway client to an Access Gateway server. 

Access Gateway Remote Connector 

The software used to create Access Gateway sessions and allow remote 

users to view or control your screen. 

Access Gateway server 

The central software component of the Access Gateway.  Installed on a 

central server that is accessible to all other Access Gateway users, the 

Access Gateway server provides communication facilities for the Access 

Gateway Remote Connector and client components. 

Access Gateway session 

An individual remote control session, established by a user running the 

Access Gateway Remote Connector and identified with a short access code. 
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account isolation 

A feature of the Access Gateway server, allowing the administrator to 

individually control which Access Gateway accounts are allowed to connect 

to sessions created by other accounts (see basic permissions and advanced 

permissions.) 

advanced permissions 

The additional access permissions and restrictions that take effect when 

account isolation has been enabled; advanced permissions consist of a list of 

Access Gateway accounts that can view a given account’s sessions, and vice 

versa.  (See account isolation and basic permissions.) 

B 

basic permissions 

The set of access permissions associated with every Access Gateway 

account, whether account isolation has been enabled or not; basic 

permissions control whether an account can be used for connections from 

the Remote Connector and/or the Access Gateway client. 

C 

channel 

A connection between a viewer and a session; the Access Gateway is 

licensed based on maximum concurrent open channels.  Each individual 

viewer of a session counts as using one channel, but a session with no 

connected viewers does not count towards the number of licensed channels. 

M 

multiuser session 

A type of Access Gateway session that allows multiple viewers to connect to 

it simultaneously.  Users may connect and disconnect freely until the session 

is closed. 

N 

non-persistent session 

A type of Access Gateway session that is created interactively by a user 

using the Remote Connector.  A non-persistent session can only be used 

until the user closes the Remote Connector. 
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O 

One-Click Connector 

A small self-contained program that is customized with your Access 

Gateway details and configuration settings.  Users can create Access 

Gateway sessions by simply running your One-Click Connector package 

(e.g. after having downloaded it from your intranet), without any 

requirement to install the Remote Connector ahead of time. 

P 

persistent session 

A type of Access Gateway session that runs in the background and remains 

available whenever the Remote Connector is running.  Persistent sessions 

retain their access codes even when the Remote Connector is shut down and 

restarted. 

R 

registration (see also Access Gateway registration) 

The process of creating an Access Gateway registration from within the 

Remote Connector or the Access Gateway client. 

registration file 

see Access Gateway Registration file 

S 

session 

see Access Gateway session 

single-use session 

A type of Access Gateway session that can only be connected to once; after 

the remote user has connected, the session’s access code is no longer valid 

for any other users to use. 

SysMan 

A family of system management products from Sysgem; used to refer to any 

member of the SysMan family, e.g. SysMan Remote Control or SysMan 

Utilities. 

SysMan Explorer 

The tree view window to the left of the SysMan workspace, showing all 

computers, Access Gateways and management options available to the user. 

SysMan Professional 

A product in the SysMan family that provides the same features as SysMan 

Utilities, along with multi-user support for central authentication, auditing 

and authorization. 
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SysMan Remote Control 

A product in the SysMan family that provides just the Remote Control and 

Access Gateway-related features, as opposed to the full set of Windows 

management utilities available in other SysMan products. 

SysMan Remote Control client 

The GUI application that allows a user to interact with a SysMan Remote 

Control Server or an Access Gateway session.  Included with and installed 

as an integral part of all SysMan products. 

SysMan Remote Control Engine 

The underlying component of the Access Gateway Remote Connector and 

SysMan Remote Control Server that provides them with remote control 

capabilities.  The SysMan Remote Control Engine configuration includes 

various settings that are shared between the Remote Connector and Remote 

Control Server running on the same computer. 

SysMan Remote Control Server 

The server component of SysMan Remote Control, allowing direct access to 

computers in a LAN environment. 

SysMan Utilities 

A product in the SysMan family that provides Windows management tools 

as well as all of the Access Gateway management and client facilities 

included in SysMan Remote Control. 

W 

Windows Management Instrumentation 

A Microsoft technology allowing remote administration and configuration 

of Windows systems; used by SysMan and the Access Gateway 

management tools to work with remote computers. 

WMI 

see Windows Management Instrumentation 
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